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COBOL-IT Developer Studio Topics  

Introduction 

This document describes how to install and how to use the COBOL-IT Developer Studio, 

which is COBOL-IT’s eclipse-based development environment, designed to support users of the 

COBOL-IT Compiler Suite.  COBOL-IT is based on OpenCOBOL, originally developed by 

Keisuke Nishida and maintained since 2007 by Roger While.  In 2008, COBOL-IT forked its 

own compiler branch, with the intention of developing a fully featured product and offering 

professional support to the COBOL user industry. 

 

COBOL-IT Developer Studio License terms 

The copyright for the COBOL-IT Developer Studio® is wholly owned by COBOL-IT. 

Unauthorized reproduction of the software without the express written consent of COBOL-IT 

is prohibited. 

 

For more information, please contact us at: contact@cobol-it.com 

 

COBOL-IT Corporate Headquarters are located at 

 

231, rue Saint-Honore 

75001 Paris 

Tel: +33.1.75.43.05 

Email: contact@cobol-it.com 

 

COBOL-IT, COBOL-IT Compiler Suite, CitSQL, CitSORT, CitXML, and COBOL-IT 

Developer Studio are trademarks or registered trademarks of COBOL-IT. 

Eclipse is a trademark of the Eclipse Foundation. 

IBM, and AIX are registered trademarks of International Business Machines Corporation. 
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Windows, Visual Studio, and Visual Studio Express are registered trademarks of Microsoft 

Corporation. 
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UNIX is a registered trademark of The Open Group 
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All other trademarks are the property of their respective owners. 
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Dependencies 
Dependencies for the Developer Studio are: 

Dependency  Comment  

“C” compiler  The COBOL-IT Compiler requires a “C” compiler.  While most 

Linux>Unix installations will include a “C” compiler, many Windows 

installations will not.  Windows users can download the Visual Studio 

from www.microsoft.com.  

COBOL-IT Compiler 

Suite  

The COBOL-IT Compiler Suite, Standard Edition can be downloaded 

at the COBOL-IT Online Portal.  For access to the COBOL-IT Online 

Portal, please contact your sales representative at sales@cobol-it.com.   

Java Runtime 

Environment (JRE)  

The COBOL-IT Developer Studio Kepler build can be run with the 

Java Runtime Environment (JRE) Version 1.6 or greater.  The 

COBOL-IT Developer Studio Neon build can be run with the JRE 

Version 1.8 or greater.   

Eclipse  Eclipse is included with the download of Developer Studio.  

 

The COBOL-IT Developer Studio Distribution 

For Windows-based installations, the COBOL-IT Developer Studio, Enterprise Edition can be 

downloaded  from the COBOL-IT online portal with a login and password provided by your 

sales representative.   

The COBOL-IT Developer Studio, Enterprise Edition is available with Subscription.  The 

COBOL-IT Developer Studio, Enterprise Edition provides functionality with the installation of 

several Perspectives:  

• Developer Studio Perspective in which users set up and build COBOL projects, using a 

locally installed version of the COBOL-IT Compiler Suite Enterprise Edition.  The 

Developer Studio Perspective additionally provides access to Code Coverage and 

Profiling Tools.   

• Debugger Perspective providing access to a feature-rich COBOL debugger both locally, 

and on Remote Systems 

• Remote Systems Perspective, allowing use of Compiler, Runtime, and Debugger 

functionalities installed on remote servers. 

mailto:sales@cobol-it.com
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• Git and RSEGit Perspectives, providing users with full access to the Git/Github Source 

Code Control System. 

• Data Displayer Perspective, providing access to a tool for browsing and modifying data 

in indexed, sequential and relative files. 

• Planning Perspective, providing access to the Mylyn Task Manager. 

• For more information about the usage of Git/RSEGit, Data Displayer, Mylyn Task 

Manager, and Code Coverage, see the Getting Started with the Developer Studio- The 

Utilities Manual. 

• Using the COBOL-IT Developer Studio requires a license for both the COBOL-IT 

Compiler Suite Enterprise Edition, and COBOL-IT Developer Suite.   
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The Debugger Perspective 

Configuration of the Debugger Perspective 

Window>Preferences>Run/Debug>Perspectives 

Set “Open the associated perspective when launching” to “Always”.  This will have the effect of 

causing the Debugger Perspective to open when clicking on the Debug  toolbar button, or 

pressing F11. 
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Window>Preferences>General>Keys  

Debugger Hot Keys can be configured in the Window>Preferences>General>Keys interface. 

Pre-set Debugger Hot Keys include:  

 

Debugger Function Hot Key  Usage 

  Step Into   
F5 The Step Into function single steps through lines 

of code.  The Step Into function enters 

paragraphs/subprograms that are the targets of 

PERFORM / CALL statements. 

  Step Over 
F6 The Step Over function can be executed when 

positioned on a PERFORM or CALL statement.  

The Step Over Into function causes  

paragraphs/subprograms that are the targets of 

PERFORM / CALL statements to be executed, 

and then Steps to the next line of code.  

  Step Return F7 The Step Return function can be executed when 

positioned inside a paragraphs/subprogram that 

is the target of a PERFORM / CALL statement.  

When executed, the rest of the code in the 

paragraph/section/subprogram is executed, and 

the program returns to the next line after the 

PERFORM / CALL statement. 

  Resume F8 Resumes the execution of the program.   

Debug 
F11 Runs a source file in Debug mode.  Select a 

program, and click on the Debug toolbar button 

or press F11.  The Debugger Perspective is 

launched, a console window is opened, and 

execution is  suspended on the first line of code 

in the procedure division, which is marked in the 

COBOL-IT Program View with an arrow  

indicator. 

  Terminate 
Ctrl+F2 Terminates the program being debugged.   

  Run 
Ctrl+F11 Runs the program, skipping all breakpoints. 

Toggle Breakpoint Ctrl+Shift+B Sets a breakpoint where one does not previously 

exist, or removes a breakpoint where one does 

previously exist.  Press Ctrl+Shift+B to either 

create a breakpoint, or remove an existing 

breakpoint.  The Toggle Breakpoint function 

causes the Breakpoints View to be updated. 
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Important Debugging Operations 

Opening the Debugger Perspective  

Open Perspectives Tab 

The Debugger Perspective can be opened through the Open Perspectives dialog window. 

 

Click on the Open Perspectives push-button in the upper-right corner of the Developer Studio, 

select Other…, and then click on COBOL-IT Debugger in the Open Perspective Window.  This 

opens the Debugger Perspective directly. 

   

 
 

 

Press the Debug  button, or press Fn+F11 

Select a source file that has been set up in the project, and press the Debug  toolbar button, 

or hold down the Fn key and press F11.  Note that by default, the Debug function is associated 

with the F11 key in the Window>Preferences>General>Keys interface, as described above.   

 

The Debug function uses the default compiler flags associated with the program to compile it, if 

a Build is required, and then uses the runtime configuration described for the program to set the 

appropriate environment variables.  Pressing the Debug button or pressing Fn+F11 then will 

initiate the execution of the selected program in the Debugger Perspective.    
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Use the Debug As function 

The Debug As function is similar to the Run As function.  A Debug Configuration can be 

configured to contain environment variables needed for debugging purposes.  

   

 
 

We name our new Debug Configuration “holidaysIX.dbg” and associate our new Debug 

Configuration with the program “holidaysIX.cbl”. 
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The Runtime tab contains default runtime settings.  No changes are necessary.   

 

The Source tab is useful if the debugger needs to locate your source file.  No changes are 

necessary. 

 

The Environment tab allows you to set runtime environment variables that are only useful in 

debugging situations.  In the case below, we can see that COB_FILE_TRACE is set to Y, for 

example.  To use this debug configuration, click Apply, and then click Debug. 

 

 

The Debug View 

In the image below:  

 
 holidaysIX.dbg is the name of the debug configuration 

 COBOL Program is the class of program running 

 Region(0) is the first thread running in the Program 

 HOLIDAYSIX () line 32 represents the compiled object/current line of execution 

 C:/COBOL/COBOLIT…./eclipse.exec_script1.bat is the name of the batch file  

executing the debugger process. 

 

When focus is on the compiled object, as in the image above,  all of the debug functions on 

the toolbar are enabled.  In this mode, user steps/runs through the program, stopping at 

breakpoints.  Note that the current line of execution is recorded in the Debug View Window.  
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Step/Run/Terminate Functions 

Single-Step 

With the cursor positioned on a line of code, use the Single-Step/Fn+F5 function to advance to 

the next line of code.  In this case, the cursor will then be positioned on line:  

33: PERFORM load-indexed-file. 

 

 

Step Over 

With the cursor positioned on a PERFORM or CALL statement, use the Step Over/Fn+F6 

function to cause all of the code in the target of the PERFORM/CALL to be executed, and then 

advance to the next line of code.  In this case, the cursor will then be positioned on line:  

35: CLOSE holidaysIX. 
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Step Return 

With the cursor positioned inside the target of a PERFORM statement, on a line of code, 

use the Step Return/Fn+F7 function to execute the rest of the code in the target paragraph, and 

then advance to the next line of code.  In this case, the cursor will then be positioned on line:  

35: CLOSE holidaysIX. 

This action of the Step Return  (F7) command will pause on Format 1/Format 2 ACCEPT 

Statements, and will pause on breakpoints. 
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Resume 

The Resume (F8) command causes the program to run normally until it reaches a 

breakpoint or until the program is terminated.   When a breakpoint is reached, the program re-

enters a debugging mode, and stepping operations can be resumed.   In this case, the cursor will 

then be positioned at the breakpoint on line:  

36: DISPLAY “all done” line 21 col 30. 
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Terminate 

The Terminate command terminates debugging session, and terminates the program at the 

current line of execution. 
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The Variables View 

Refreshing the Variable View  

 By default, the COBOL-IT Debugger Perspective is configured to Auto-Refresh the 

Variable view.   

 

 
 

If you have a very large Working-Storage Section, this may not be desirable.  Under these 

conditions, it could be preferable for the user to select the Manual Refresh  on the Variables 

View toolbar, and use the Expressions View for auto-refresh of selected variables.  

Change the value of a variable  

In the Variable View, you can change the value of a variable by selecting the variable in 

 the Variable View, right-clicking, and selecting Change Value…   In the Change Value dialog 

screen,  type over the existing value, and the Variable View will be updated with the new value.  

Debugging can proceed with the new variable value. 
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Verify that the change has been made, and continue with debugging. 

Change the hexadecimal value of a variable  

The COBOL value dialog screen allows the user to set the value of a variable in either 

Hexadecimal or Text.  In the Variable View, you can change the COBOL value of a variable by 

selecting the variable in  the Variable View, right-clicking, and selecting Edit hexadecimal 

value…   The Set Value (hex) dialog screen allows you to enter a new value for the selected 

variable.   Type over the existing value, and the Variable View will be updated with the new 

value.  Debugging can proceed with the new variable value.   
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Create a Watch for a variable 

You can add a Variable to the Expressions View  by selecting the variable in the Variable 

View, right-clicking, and selecting Watch….  The Variable and its current value are 

transferred into the  Expressions View Window.   De-select “Auto-refresh” when using 

Expressions for best performance.  
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Open the Expressions View to limit the number of variables you are following. 
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Breakpoints 

Toggle Breakpoints from within the Editor Window 

You can toggle a line breakpoint ( set or unset ) by double-clicking  in the left-most column of 

the Editor Window.   This is the column to the left of the line-number columns, and is where the 

small circle that represents a breakpoint can visually be seen in your source code.    

Toggle Breakpoints from within the Breakpoints View Window 

When you have created a breakpoint, you will see that it has been added to the Breakpoints View 

window, and that the enabling checkbox is checked.   To remove a breakpoint from the 

Breakpoints View, select the breakpoint, open the right-click dropdown menu, and select the 

Remove function. 

Disable a breakpoint  

You can Disable a breakpoint by right-clicking on the breakpoint in the COBOL-IT Program 

View, and selecting the Disable function, or by right-clicking on the breakpoint declaration in the 

Breakpoints View screen, and selecting the Disable function, or by de-selecting the breakpoint’s 

enabling checkbox in the Breakpoints View screen.   Note- Disabling a breakpoint is different 

than removing a breakpoint in that it can subsequently be enabled.  You can enable a disabled 

breakpoint using the same right-click interfaces used to disable the breakpoint. 

Skip all breakpoints 

You can disable all breakpoints by clicking on the Skip All Breakpoints  pushbutton on the 

Breakpoints View toolbar. 

Run>Add COBOL Label Breakpoint… 

Select the Run function on the main menubar, right-click, and select Add COBOL Label 

Breakpoint… from the dropdown menu.   Enter the label name of a paragraph or section and 

click OK.  With a COBOL Label Breakpoint, a breakpoint condition occurs every time that the 

label is encountered. 
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Run>Add COBOL Value Change Breakpoint 

Select the Run function on the main menubar, right-click, and select Add COBOL Value Change 

Breakpoint… from the dropdown menu.  Enter the variable name, and click OK.  With a 

COBOL Value Change Breakpoint, a breakpoint condition occurs every time that the value of 

this variable changes.  The COBOL Value Change Breakpoint can be used with a variable being 

watched in the Expressions View. 
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Expressions 

Add a new expression 

To add a new expression, you can click on the “Add new expression” button on the Expressions 

toolbar, or you can click on the in-line “Add new expression” function.  Clicking on the inline 

“Add new expression” function allows the user to type the expression directly into the “Name” 

column.  
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Code Editor Functions 

Show Line Numbers 

You can Show or Hide Line Numbers by right-clicking in the left-most column of the Editor 

Window, and checking or unchecking the Show Line Numbers function. 

Transferring control to console on ACCEPT 

The behavior of the COBOL-IT Debugger when positioned on an ACCEPT statement is worth 

noting.   When stepping through code, the current line is marked by an arrow in the left-most 

column of the current line.  The source code on the line is colorized (green) before the code is 

executed. 

    

 
 

Normally, the single-step process will move this arrow, and this colorized source line by line 

through the code.  However, in the case of the ACCEPT statement, the debugger must pause, and 

wait for input from the console.     

 

In the case above, press F5 to single-step.  This executes the ACCEPT statement, but does not 

move the line.  The debugger signals the user that it is paused and waiting for input by changing 

the colorization of the current line.  See below: 

  

 
 

At this point, the user must raise the console, and perform the operation that terminates the 

accept.  In this case, hit the [Enter] key. 
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COBOL-IT Debugger Reference 

The Views in the COBOL-IT Debugger Perspective  

 

The functionality of the COBOL-IT Debugger Perspective is presented through the View 

interfaces.   A quick overview of the main Views in the COBOL-IT Debugger Perspective is 

instructive:  

 

Debugger Perspective View Functionality 

The Debug View A view of the stack executing in the Debugger 

The COBOL-IT Program View A COBOL-IT Code Editor which is animated 

during debugging 

The Variable View Working-Storage, Linkage Section, File 

Section can be expanded to see values 

The Breakpoints View Lists status of all breakpoints 

The Expressions View Lists all Watches that have been set 

The Outline View An Outline of the active source file 

The Console View Consoles include the COBOL-IT Compiler,  

runtime, and debugger consoles. 

The Tasks View Provides an interface for tracking tasks 

The Problems View Provides a clickable interface for locating 

compiler errors in source code. 

The Debug View 

The Debug View shows a stack view of the execution of  your program.  In the graphic below, 

you can see the the program is currently executing at line 32 in the the program HOLIDAYSIX. 
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The Debug view toolbar   

 

The functions that are presented on the Debug View toolbar help manage the visual display of 

the call stack in the View, and the commands used to navigate inside a debugging session.  

 

 Remove all terminated launches Clears terminated launches from the Debug 

View 

 Connect to a process Initiates a Remote Debugging session. 

 Resume (F8) Resumes the execution of the program.   

 Suspend Suspends execution of the program, and re-enters 

the debugger. 

 Terminate (Ctrl+F2) Terminates the currently running process. 

 Disconnect Terminates a Remote Debugging session. 

 Step Into (F5) The Step Into function single steps through lines 

of code.  The Step Into function enters 

paragraphs/subprograms that are the targets of 

PERFORM / CALL statements. 

 Step Over (F6) The Step Over Into function causes  

paragraphs/subprograms that are the targets of 

PERFORM / CALL statements to be executed, 

and then Steps to the next line of code.  

 Step Return (F7) The Step Return function causes code in a 

paragraph/section/subprogram to be executed, 

and then Steps to the next line of code after the 

parent PERFORM/CALL statement. 

 Drop to Frame Not Supported in the COBOL-IT Debugger 

Perspective 

 Instruction Stepping Mode Not Supported in the COBOL-IT Debugger 

Perspective 

 Use Step Filters Not Supported in the COBOL-IT Debugger 

Perspective 

 View Menu Drops down a view of Menu options 
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The COBOL-IT Program View 

 

The COBOL-IT Program View is a COBOL Code Editor that is responsive to the commands 

described in the Debug View.     In the graphic below, note the arrow  positioned on line 32.  

This marks the line of code that the debugger will execute next.   Note also the circle  

positioned on line 37.  This marks a breakpoint, that is set within the source code. 

 

 
 

The COBOL-IT Program View Toolbar  

 

The functions that are presented on the COBOL-IT Program View toolbar allow the user to 

either Minimize or Maximize the Code Editor Window.  
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The Variable View 

 

The Variable View provides a graphical user interface in which the variables/values of the File 

Section, Working-Storage Section, and Linkage Section are displayed.   The Right-Click drop-

down menu from a selected Variable in the Variable View provides:  

 

Select All  Ctrl+A Select all variables and copy to clipboard 

Copy Variables           Select one or more variables and copy to clipboard 

Find...                          Search for a variable name in the Variable View 

Change Value...          Modify the value (Ascii) of a variable 

Edit hexadecimal value… Modify the value (Hexadecimal) of a variable 

Watch                         Copy a variable into the Expressions View 

 

 
 

The Variable View Toolbar  

 

The functions that are presented on the Variable View toolbar allow the user to expand/collapse 

groups of variables.   Options exist for Auto-Refresh and Manual Refresh of variable values.   

 

 Show Type Names Not Supported in the COBOL-IT Debugger 

Perspective 

 Show Logical Structure COBOL data items are all presented in their 

logical structures, and can be expanded and 

collapsed. 

 Collapse All (Ctrl+Shift+Numpad-

Divide) 

Collapses all structures back to their parent 

Sections ( Working-Storage, File, Linkage ) 

 Refresh Manual Refresh function.  In programs with 

large numbers of variables,  avoids degradation 
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of performance associated with Auto-Refresh. 

 Auto Refresh Auto-Refresh function.  Working Storage, File 

Section, and Linkage Section are auto-refreshed 

in real time, while debugging the program. 

 Add Global Variables Not Supported in the Debugger Perspective 

 Remove Selected Global Variables Not Supported in the Debugger Perspective 

 Remove All Global Variables Not Supported in the Debugger Perspective 

 View Menu Drops down a view of Menu options 
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The Breakpoints View 

 

The Breakpoints View is a single interface for managing all of the breakpoints in all of the 

programs that you have open in the Debugger Perspective.  Breakpoints can be set at line 

numbers, on labels, or on variable value change.  

 

 
 

Hit Count 

When you create a breakpoint, you can assign a Hit Count for it.  Hit Count is a number.   

If you set the hit count for a breakpoint to 5, for example, then the breakpoint will occur after the 

condition has been hit 5 times.  

 

 
 

 

The Breakpoints View Toolbar 

 

The functions that are presented on the Breakpoints View toolbar allow the user to manage 

breakpoints.    Selected breakpoints can be removed, all breakpoints can be removed, . 
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 Remove Selected Breakpoints Removes breakpoints that have been selected by 

clicking in the checkbox in the left-most  

column.   

 Remove All Breakpoints Removes all breakpoints. 

 Show Breakpoints Supported by 

Selected Target 

Shows all breakpoints set in the COBOL 

programs. 

 Go To File for Breakpoints Transfer focus to file at Breakpoint 

 Skip All Breakpoints Disable ( but do not remove ) all breakpoints. 

  Expand All Not Supported in the COBOL-IT Debugger 

Perspective 

 Collapse All Not Supported in the COBOL-IT Debugger 

Perspective 

 Link With Debug View Not Supported in the COBOL-IT Debugger 

Perspective 

 View Menu Drops down a view of Menu options 

 

 

The Expressions View 

 

The Expressions View is an interface for managing a select number of variables.  If you wish to 

have an auto-update capability of just a small number of variables, and the performance penalty 

of running the debugger with Auto-Refresh on for all variables is too high, you can use the 

Expressions View to minimize the number of variables on Auto-Refresh.   
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Qualified names in the Expression View 

The debugger supports qualified names, such as data-element-1 in group-2 in the Expression 

View.  Navigate to a qualified description of othe data item in the source code, right-click and 

select Watch from the dropdown menu.  

 
 

The qualified data item is copied to the Expression View. 
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The Expressions View Toolbar 

 

The functions that are presented on the Expressions View toolbar allow the user to manage 

Expressions.    Expressions can be created, collapsed, expanded, and removed.  

 

 Show Type Names Not Supported in the COBOL-IT Debugger 

Perspective 

 Show Logical Structure COBOL data items are all presented in their 

logical structures, and can be expanded and 

collapsed. 

 Collapse All (Ctrl+Shift+Numpad-

Divide) 

Collapses all structures . 

 Create a new Watch Expression Opens dialog window in which a new Watch 

Expression can be described.  Note that Watch 

Expressions can also be added from within the 

Variable View, by right-clicking on a variable, 

and selecting “Watch” from the dropdown menu. 

 Remove Selected Expressions Removes expressions that have been selected by 

clicking on them. 

 Remove All Expressions Removes all expressions listed in the 

Expressions View. 

 View Menu Drops down a view of Menu options 
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The Outline View 

 

The Outline View is an interface for viewing the source file in Outline form.  The Outline View 

is linked to the COBOL-IT Program View, as clicking on any of the entries in the Outline View 

highlights the corresponding line of code in the COBOL source file. 

 

 
  

The Outline View Toolbar 

 

The Outline View Toolbar contains an Alphabetic Sort function.  

 

 Focus on Active Task Not Supported in the COBOL-IT Debugger 

Perspective 

 Sort Sorts the Outline view alphabetically 

 View Menu Drops down a view of Menu options 

 

 

The Console View 

 

The COBOL-IT Compiler Console View allows you to view the output of the compiler 

command that has been executed. 
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The Console View Toolbar 

 

The Console View Toolbar allows you to manage the selection of open consoles, and provides 

the ability to clear the console. 

 

 Clear Console Clears all text from the open console window. 

 Scroll Lock Not Supported in the COBOL-IT Debugger 

Perspective 

 Pin Console Not Supported in the COBOL-IT Debugger 

Perspective 

 Display Selected Console Allows selection of a console from a dropdown 

list to be the active console in the output 

window.   For example, select the COBOL-IT 

Compiler console to see output from the 

Compiler on Build operations. 

 Open Console Adds a new console to the Display Selected 

Console dropdown list of available consoles. 

 

The Tasks View 

The Tasks View toolbar provides access to the Mylyn Task Manager.  For details on how to use 

the Task Manager, see Getting Started with the Developer Studio- The Utilities. 

 

 
The Tasks View Toolbar 

 

 

 Focus on Active Task Places focus in active source file. 

 View Menu Drops down a view of Menu options 
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The Problems View 

 

The Problems View provides a clickable interface for returning from reported compiler errors to 

their location in the source file.   

 

 
 

The Problems View Toolbar 

 

 Focus on Active Task Places focus in active source file. 

 

 

View Menu Drops down a view of Menu options 

 
 

Attaching the Debugger to a Running Process 

Is it possible to attach the COBOL-IT Debugger to a program, or subprogram that is running, at a 

selected place in the program or subprogram ? 

 

C$DEBUG is a library routine which can be called using either the PID of the runtime session, 

or the value of the environment variable COB_DEBUG_ID.  Prior to calling C$DEBUG, the 

program should acquire the value of the PID / COB_DEBUG_ID. 

 

You may acquire the value of the PID of the runtime session by calling the C$PID library 

routine, using a PIC 9(n) parameter.  The parameter must be numeric, and large enough to hold 

the value of the Process ID. 

 

For example :  

77 ws-pid       PIC 9(5). 

….. 

CALL « C$PID » USING ws-pid.  

CALL « C$DEBUG » USING ws-pid. 

 



           

 

COBOL-IT Developer Studio– Getting Started 

The Debugger Perspective  Version 2.0 

 

 

 

 
Page 37 

 

 

You may also call C$DEBUG USING the value of the runtime environment variable 

COB_DEBUG_ID.  Using the runtime environment variable COB_DEBUG_ID to hold the 

value of this parameter has an advantage if you prefer to set the value of the parameter yourself.   

Acquire the value of COB_DEBUG_ID programmatically before calling the C$DEBUG library 

routine.  The parameter must be numeric, and large enough to hold the value of the value of the 

runtime environment variable COB_DEBUG_ID. 

 

For example : 

77 ws-did     PIC 9(5). 

…..  

ACCEPT ws-did FROM ENVIRONMENT « COB_DEBUG_ID ». 

CALL «C$DEBUG » USING ws-did. 

 

After a call to C$DEBUG is made, the executing program, or subprogram is paused.  In this 

state, the COBOL-IT Debugger may be attached to this runtime process from the COBOL-IT 

Developer Studio.    

Key concepts  

 

In order to attach to the COBOL-IT Debugger, the program containing the call to C$DEBUG 

library routine must be compiled with –g. 

The COBOL-IT Developer Studio will request the location of the source file associated with the 

program/subprogram that has been paused by the C$DEBUG command, for purposes of 

debugging.  

The COBOL-IT Developer Studio attaching to the paused runtime session requires a COBOL 

Project, and requires that some configuration.  Recommended settings are :  

Window>Preferences>Run/Debug>Perspectives>Open the associated perspective when lauching 

(Always ) 

 

In our example,  we have a program, debugid.cbl, which calls a subprogram, subpgm.cbl, which 

retrieves the PID of the runtime session, and then calls C$DEBUG to pause the runtime session.  

We will run these programs from a batch file, as follows :  

Launch, and Pause the Runtime using CALL « C$DEBUG » 

runit.bat 

SET COB_LIBRARY_PATH=.\object 

cobcrun debugid 

 

This will return the screen below.  Note that in your case, the Process ID will likely be different. 
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Attach the Debugger from the Developer Studio 

The Developer Studio must be configured to enter the Debugger Perspective when launching the 

debugger.  In Window>Preferences>Run/Debug>Perspectives, set “Open the associated 

perspective when launching” to “Always”. 
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Create a New COBOL Project 

 

 

Select Debug Attach Function 

In the Navigator Window, right-click on the Project, and  select COBOL>Debug Attach from the 

dropdown list.  In the Debug Configuration for Reverse Attach Window, select the entry with the 

PID that matches the PID of the paused runtime session.  Click “Debug”. 
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Edit Source Lookup  Path 

The Developer Studio opens in the Debugger Perspective.  Note that there is a message, in red, 

that Source Not Found.  To associate the the source code of subpgm.cbl with the project, click on 

the Edit Source Lookup Path… button.   

 

On the Edit the Source Lookup Path Screen, the Default setting is your current Project Path.   If 

the source files are not in your Project Path ( they probably are not ), click the Add button.    
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After clicking the Add button, select File System Directory, Click Ok. 

 

Use the Browse button to locate the Source Location  
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Your selection will appear in the Edit Source Lookup Path window .  Click OK. 
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Debug in the Developer Studio 

You are now ready to debug in the Developer Studio : 

 

Use the Debugger toolbar buttons to debug your program.  
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Disconnecting the Debugger 

You may wish to disconnect the debugger and continue running your program. 

To disconnect the debugger, select the highest level of your session in the debugging view, titled 

.debug-attach.  This will enable the “Disconnect” toolbar button to the right of the Terminate 

button.  Click on the Disconnect button to disconnect the COBOL debugger without terminating 

the runtime session. 

 

Programs used in this sample 

debugid.cbl 

       identification division. 

       program-id.  debugid. 

       environment division. 

       data division. 

       working-storage section. 

       procedure division. 

       main.  

          display "In debugid" line 8 col 10. 

          call "attachit". 

          display "Back in debugid" line 12 col 10. 

          stop run. 

 

attachit.cbl 

       identification division. 
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       program-id.  attachit. 

       environment division. 

       data division. 

       working-storage section. 

       77 ws-pid  pic 9(5). 

       procedure division. 

       main. 

           display "Pausing in attachit" line 9 col 10. 

           ACCEPT ws-pid from environment "COB_DEBUG_ID". 

      *    CALL "C$PID" using ws-pid. 

           DISPLAY "DEBUG ID IS " ws-pid line 10 col 10. 

           CALL "C$DEBUG" using ws-pid. 

           DISPLAY "Carry on in the debugger" line 11 col 10. 

           EXIT PROGRAM. 

runit.bat 

 

SET COB_DEBUG_ID=12345 

SET COB_LIBRARY_PATH=C:\COBOL\COBOLIT\Samples 

cobc -g debugid.cbl 

cobc -g attachit.cbl 

cobcrun debugid 

 

Attaching a “C” debugger to a running process 

-G    

Produces debugging information in the output, allowing “C”-level debugging. 

 

To perform “C” level debugging, use the COBOL-IT Developer Studio. 

 

COBOL-IT translates COBOL to “C” and uses the host “C” compiler to compile the translated 

source.  As preparation, compile your COBOL programs with the –G compiler flag.  “C” 

modules should be compiled for debugging as well. 

 

The –G COBOL compiler flag allows the COBOL program to be include information for the “C” 

debugger.  This corresponds to the gcc –g compiler flag. 

 

Using the Debug Attach functionality of the Developer Studio to Attach the COBOL Debugger 

to an  Application, you can enter the COBOL Debugger, then start the “C” debugger, and 

proceed your debuggeing with both the “C” and COBOL debuggers running.   

 

The Eclipse IDE for C/C++ Developers, and “C” compiler are required for this exercise. 
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-fnostrip   

Causes objects and object and executable files to NOT be stripped.    

Stripping an object or an executable is the action of removing system level debugging 

information.   The –fno-strip compiler flag is enabled by the –G compiler flag.   

Overview 

Attaching a “C” Debugger to an Application is a functionality provided by Eclipse, when the 

Eclipse IDE for C/C++ Developers plug-in is installed, and the gdb debugger is installed on your 

system.   

  

As preparation, compile your COBOL programs with the –G compiler flag.  The –G COBOL 

compiler flag allows the COBOL program to be include information for the “C” debugger. 

This corresponds to the gcc –g compiler flag.  “C” modules should be compiled for debugging as 

well. 

 

We will create an executable called “newcall”, linking a “C” library compiled for debugging 

with a COBOL program compiled to allow for “C” debugging.   

 

We will start our executable from the command-line, use the Debug Attach functionality of the 

Developer Studio to Attach the COBOL Debugger to the Application. 

 

At that point, we will start the “C” debugger, and continue with both the COBOL and “C” 

debuggers running.  We will enter a CALL’ed “C” function, and use the “C” debugger.  When 

finished debugging, we can return to the COBOL program, and resume using the COBOL 

debugger. 

 

Pre-requisites  

The following must be installed on your Linux machine:  

 

COBOL-IT Compiler Suite Enterprise Edition 

COBOL-IT Developer Studio 

C/C++ Development Tooling 

The gdb source level debugger 

Sample Programs 

c_printf.c  

c_printf is called from our main COBOL program. 

We will switch to the “C” debugger before executing the CALL of this function. 
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int c_printf (char * format , char * var) 

{ 

 printf (format, var); 

 return 0; 

} 

 

newcall.cbl  
 

The  CALL “C$DEBUG” statement allows us to attach the COBOL 

debugger to a process.  After attaching the COBOL debugger to 

the process, we will then switch to the “C” debugger for the 

CALL to c_printf. 

 

IDENTIFICATION DIVISION. 

PROGRAM-ID. NEWCALL. 

     ENVIRONMENT DIVISION. 

DATA DIVISION. 

WORKING-STORAGE SECTION. 

01 ws-dummy PIC x. 

PROCEDURE DIVISION . 

     MAIN. 

         DISPLAY "NEWCALL Started" 

    CALL "C$DEBUG" USING 12345 

         DISPLAY "The PROGRAM will pause here" line  10 col 10. 

         CALL "c_printf" USING "%s" "Hello" 

    DISPLAY "Set another breakpoint here" line 12 col 10. 

         EXIT PROGRAM. 

Compile and link the sample programs 

Compile c_printf.c with debugging information, and create a shared library called “clibs.so”. 

As a shortcut, you can use cobc to compile the “C” program. In this case, use the –G compiler 

flag. 

 
>cobc –G c_printf.c  

 

c_printf.so is compiled with debugging information. 

 

Compile newcall.cbl with COBOL debugging information (-g) and C debugging information (-

G).  Link c_printf.so and create an executable (-x) called newcall.   
> cobc newcall.cbl –g –x c_printf.so –G  
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This creates an executable module called newcall, in which c_printf.so is linked to the main 

module. 

Create a New COBOL project 

Drag and drop into the project folder: c_printf.c, c_printf.so, newcall.cbl and the executable 

newcall. 

 

Open newcall.cbl in the code editor and set a breakpoint: 

  

Image 1- The COBOL Project, with files and breakpoint 
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Add C/C++ nature to the project 

Add C/C++ nature to the project. The project needs to be both a COBOL Cobol and C/C++ 

project at the same time.  

In the C/C++ Perspective , select File>New>Convert to a C/C++ Project. 

   
 
This will open the Convert to C/C++ Project Wizard:  
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In the C/C++ Perspective, open the C file and set a breakpoint:  
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In the COBOL Perspective, in the navigator window, configure the visibility of the “c” 

folder by de-selecting it:  
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Launch the newcall executable 

Run newcall from the command-line 

 

> ./newcall 

 

newcall pauses after the CALL C$DEBUG command. 

 

 

 
 

Image 2- Newcall is paused  

 

At this point, re-enter the Developer Studio. 
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The Debug Attach function 

Right-click on the Project name, and select Cobol from the menu. 

Then Select Debug Attach. 

 

 
 

Image 3 
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The Reverse Attach Window 

From the Reverse Attach Window, select Newcall. 

Click on the Debug button. 

 

 
 

Image 4- The Reverse Attach Windows 
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The COBOL-IT Debugger Attach 

Since the source file is in the project, newcall is opened directly into the COBOL-IT Debugger 

Perspective.   

 

   
Image 5- The COBOL-IT debugger is running. 
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C/C++ Debug Configuration 

To start the “C” debugger, return to the Developer Studio Perspective.  In the Navigator 

Window, select the Project by clicking on it.  Right-click on the Project to open the drop-down 

menu.  From the drop-down menu, select Debug As, and then the Debug Configurations 

function. 

 

The Debug Configurations contain the interfaces to configure the C/C++ Attach to Application 

Functionality. 
 

 
 

Image 6- Select Debug As/Debug Configurations 
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Create a new C/C++ Attach to Application 

Select C/C++ Attach to Application by clicking on it.  Click on the “New” button on the toolbar 

above the panel on the left to create a new configuration. 

 

 
Image 7- New C/C++ Attach to Application 
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C/C++ Debug Configuration- Main Tab 

The Name of your configuration is pre-filled. 

Enter the full path, and name of your C/C++ Application. 

In our case, this is the newcall application. 
 

 
Image 8- The Main Tab 
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C/C++ Debug Configuration- Debugger Tab 

No changes need to be made on the Debugger tab.  

Note that gdb is named as the debugger. 

gdb must be installed on your Linux machine. 
 

 
 

Image 9- The Debugger Tab 
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C/C++ Debug Configuration- Source Tab 

Click on the Add button.  In the Add Source Windows, select “File System Directory”. Click Ok.  

On the Directory Selection screen, select project1. Click Ok. 
 

 
 

Image 10- The Source Tab 
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C/C++ Debug Configuration- Common Tab 

No changes need to be made on the Common tab. 

Select Apply. Click on the Debug button to enter the Debugger. 
 

 
 

Image 11- The Common Tab 
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Select newcall from list of running applications 

The system opens a list of running applications. Search by name or PID. Select newcall, click 

Ok. Control returns to the debug window. 

 

 
 

Image 12- Search and select from the list of running 

applications 
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The Debugger Window- Two Debugging Sessions 

There are 2 debugging sessions in the Debug Window. One of the sessions is the COBOL 

debugger, and the other is the “C” debugger.  You are debugging the same application, but some 

of the lines are being tracked by the COBOL debugger, and some by the “C” debugger. 
  

 
 

Image 13- Two Debugging Sessions 
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The Debugger Window- Focus on C Debugger Thread 1 

Within the “C” debugger, there are 2 threads.  Thread 2 is the COBOL Debugger Runtime. 

Thread 1 is the program running. Select Thread 1 by clicking on it.   

Now, you can open c_printf and see the “C” Debugger. 

 

 
Image 14- Focus on the “C” Debugger 
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The “C” Debugger- Set a Breakpoint 

Set a breakpoint in c_printf.c. 

The breakpoint will be displayed in the breakpoint window. 

Return to newcall.cbl, and we will enter the “C” function, using the Step Into ( F5) function. 
 

 
Image 15- Set a breakpoint in the “C” compiler 
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Step Into the C Function (F5) 

With the Cursor on the CALL “c_printf” statement, use the Step Into (F5) function to step into 

the “C” program. 

Open c_printf.c to debug. 
 

 
Image 16- Step into the “C” debugger 
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The “C” debugger 

Now, you can debug on the “C” side. Variable values are in the Variable window. You can use 

the Step Functions. 

The “C” debugger will stop on breakpoints. 

Use the Continue function to return to the COBOL program.  Set a breakpoint in the COBOL 

program and resume using the COBOL debugger. 

 

 
 

[Image 17]- Stopping on a breakpoint in the “C” Debugger 

 

 

Cobol and C/C++ debugging  

 

yyyyy 

  

1. Open project debug configurations:  
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2. Configure C/C++ debug attach as shown below, note that only Main tab is 

important. Press apply and debug.  
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3. Now under Debug perspective in second debug stack frame you can find C source 

files from “c” folder which were configured on step 6.  
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4. Now there are two running debuggers. You should click "Resume" in both 

debuggers and you will see that debugger will stop on breakpoint in C program.  
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5. Now you can debug C program and when you need to switch to a breakpoint in 

Cobol source file you can just click “Resume” in C debugger and debugger will stop 

on next Cobol breakpoint.   

  

 

 

 

In parting… 

C/C++ Attach to Application is included with the Eclipse IDE for C/C++ Developers, and 

required. 

Gdb cannot be run as a remote debugger.  Both your main COBOL program and “C” program 

must be compiled with the –G compiler flag. 
 

Attaching to the Debugger when calling COBOL from “C” 

C$DEBUG is a COBOL  routine, so it can only be called from within a COBOL program.  In a CICS 

environment, what is needed is a mechanism to set up the reverse attach debugger connection before 

the program is called.  Can COBOL-IT provide an API function that can be called before the program 

is called, so that when the runtime is started from « C », the runtime can set the breakpoint at the start 

of the program, and attach to the debugger with the specified debug-id ? 

 

Yes- Before stating the entry COBOL program, call :  
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cob_runtime_debugger_activate(rtd, did); 

 

Where did is the debug ID used in eclipse to connect to the debugger.  The runtime will then stop on the 

next COBOL statement.  
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